
PowerPoint Tips

Copyright 2002, CNC Concepts, Inc., 44 Little Cahill Road, Cary, IL  60013  
ph:847-639-8847   fax:847-639-8857   email: lynch@cncci.com internet:www.cncci.com

Instructor Notes
Tips for teaching CNC courses from CNC Concepts, Inc. 

Issue 8 Winter 02

We’ve just updated our 
turning center curriculum –
here’s what’s new…
We’ve made four improvements to the 
instructor materials (student materials 
remain the same).  These updates 
parallel those recently done in the 
machining center curriculum – so both 
curriculums now have the same new 
features. If you use this curriculum, 
request your FREE update today!
Presentation links slide in every 
lesson – We’ve made each lesson 
more interactive.  Instead of having to 
find the slide that begins each topic on 
your own, we’ve added a special links 
slide in each lesson.  This lets you 
start/continue your presentation at the 
start of any major topic in the lesson. 

Each underlined topic is a text link 
that, if clicked, will send the 
presentation to the chosen topic within 
the lesson.  To get back to the 
presentation links page, simply click 
the return button in the lower left 
corner of any slide. 
If you want to present the lesson in its 
entirety, simply skip this slide (use the 
slide advance key). If class time ends 
before you finish a lesson, this slide 
should make it easy to continue from 
where you left off in your next session.
As you’re preparing to teach, you may 
decide not to include certain topics in

Editor’s note
Microsoft PowerPoint is fast becoming 
the software product of choice for 
professional presenters.  Each issue of 
Instructor Notes will include 
PowerPoint Tips to help you improve 
your slide show development skills.

Page Layout with PowerPoint
PowerPoint is great for putting what 
you want where you want it!
PowerPoint is well known for its slide 
show capabilities.  You can truly 
develop captivating presentations 
incorporating all kinds of built in tools –
including custom animation, word art, 
and drawing tools of all kinds.  
Additionally, you can import just about 
any kind of graphic, including 
computer art, photographs, and even 
movies.  And the development views –
slide view, outline view, and slide 
show view – make PowerPoint very 
easy to work with.
What is not as well publicized is 
PowerPoint’s abilities for desktop 
publishing.  The same great layout 
tools that help you create slide show 
presentations also allow you to create 
fast and easy documents for printing.
I’ve worked with a few desktop 
publishing programs – our manuals 
are all developed with Ventura 
Publisher.  And I’ve used my share of 
word processors.  Frankly speaking, 
PowerPoint has become my software 
program of choice for developing short 
(up to ten page) documents –
especially if they incorporate any 
graphic layout.  By the way, I create 
this newsletter using PowerPoint.
Getting started
Under File, when you select New, 
PowerPoint assumes that you’ll be 
creating an on-screen slide show 
presentation and automatically sets up 
for screen display.  You’ll need to 
select Page Setup ( also under File) 
and in the Slides sized for choice, 
select letter paper.  Also, PowerPoint 
defaults to landscape orientation.

If you want Portrait orientation, you 
must select it.  After clicking OK, you’ll 
be shown a blank page in the work 
area.  Note that items can appear 
pretty small, so remember that you 
can scale the working area to a size 
that suits your needs.
Getting things where you want 
them
If you’ve created slide show 
presentations with PowerPoint, you 
already know the selection of tools 
available for placing items in the 
working area.  But when it comes to 
documents that must be printed 
(forms, brochures, quizzes, fliers, 
etc.), you usually want more precision 
than you need with a slide show. I like 
to keep the Snap-to-Grid function 
turned on, so items stay in line.
Working with text
The text box tool lets you place text in 
any location.  As with any word 
processor, you’ll be able select font, 
size, and special attributes (bold, italic, 
etc.).  You’ll even have automatic spell 
checking during typing.  But unlike 
most word processors, you’ll be able 
to place your text in any location in the 
document working area.  And you’ll be 
able to constrain text in columns of 
any width.  Using Line Spacing (under 
the Format menu), you can also set 
spacing between paragraphs.  One 
thing I especially like about Power-
Point is this ability to place/move text.

Instructor Notes is published quarterly 
by CNC Concepts, Inc. and distributed 
free of charge to instructors that teach 
CNC courses.  Simply contact us to 

begin your subscription!

Teaching with our curriculums?
Recent developments…
! Turning center curriculum has 

been updated. If you are using this 
curriculum and have not yet received 
the free update, please call us.

! Curriculum update information 
now on our website. This page 
includes corrections to known 
problems, update information, and 
other important information about 
our curriculums.

continued pg 2
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It’s extremely helpful with forms and 
fliers, when you don’t know for sure 
how something is going to look until 
you see it. 
Drawing tools
PowerPoint provides a healthy 
selection of drawing tools to help you 
create graphics.  Standard shapes 
include lines, rectangles, circles, 
arrows, and a whole range of special 
shapes (boxes, cylinders, polygons, 
hearts, and many more).  Once drawn, 
you can size and place them with ease.
Importing other objects
Again, one of PowerPoint’s strengths is 
importing ability.  In almost all cases 
you can simply Insert the item (using 
the Insert menu).  Once inserted, 
PowerPoint makes it easy to size and 
move the object to any location in the 
working area.
Modifying your document
Again, I feel this is one of PowerPoint’s 
strong points.  The large selection of 
editing tools (copy, cut, paste, 
duplicate, & group make it possible to 
easily fine tune even the most 
complicated documents.  I especially 
like the ability to copy work done in one 
document and use it over and over 
again in other documents.
Printing
When you’re finished, you can print 
your document (using the Print
selection of the File menu) just as you 
do with any word processor or desktop 
publisher.  What you see in the working 
area will be precisely printed.  That is, 
PowerPoint is truly a What you see is 
what you get (WYSWYG) software 
application.

End

Publicize your school
We maintain a schools forum on our 
website (www.cncci.com). It’s free –
and it’s a great way to let potential 
students know about your CNC-related 
courses!
Simply fill in an online form that asks 
for some general information about 
your CNC courses, lab equipment, and 
degree information.  About half the 
schools currently listed are using our 
CNC curriculums to help them teach 
CNC courses!

Teach CNC with the 
best materials!

Curriculum update…(cont. from pg 1)
your presentation.  Perhaps you want to 
skip them for now and come back to 
them later.  In this case, when you get 
to the topic you wish to skip, simply 
click on the return button to get back to 
the presentation links page.  Then click 
on the topic after the one you wish to 
skip.
This slide will also make it much easier 
to review.  It makes a great set of bullet 
points, helping you remember the topics 
that must be reviewed.  If students are 
having problems with a topic during the 
review, you can simply click on the topic 
and present the material again.  
Instructor Notes manual – This 
version of the curriculum still includes 
the set of slides containing audio 
guidance, and we think you’ll agree that 
it makes the easiest way to gain an 
understanding of how to present each 
topic throughout the course.  While we 
feel this audio guidance is extremely 
helpful, we’ve received several 
suggestions from instructors saying they 
want a way to prepare to teach without 
having to have a computer available –
and that they’d like a way to make notes 
of their own as they present the course.
The Instructor Notes manual contains 
information that parallels what is done 
with audio guidance, giving you another 
way to prepare to teach.  But we do not 
include every slide in this manual (there 
are over 5,000 slides in the curriculum).  
Instead, we’ve picked key slides at 
transition points and provided a short 
description of how to present the topic.  
Even so, this manual is 830 pages long!  
Here is a sample page from the 
Instructor Notes manual.

Fly-in text boxes – Regardless of how 
much preparation you do, it’s 
impossible to memorize every topic.  
Again, there are over 5,000 slides.  It 
can be especially difficult during 
transition points, when the presentation 
is shifting gears. For this reason, most 
transition slides now include fly-in text 
boxes to help you stay on track. Some-
times the fly-in text box will keep you 
from forgetting to make a key point.  
Other times it will help at a transition 
point to remind you about where the 
presentation is going.  In many cases, 
what is in the text box can be used as 
your first sentence for the slide, helping 
you quickly dig into the material
Review slide presentation – It it
extremely important to review key 
information on a regular basis.  In this 
presentation, we begin each key 
concept with a list of lessons related to 
the key concept.  This lets you re-
stress the importance of each key 
concept.  We then include the 
presentation links slide for each lesson 
in the key concept, helping you 
remember topics that need reviewing. 

End
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! Instructor’s manual – Includes instructions 
for teaching the course, a course outline, a 
hard copy of review slide presentation, an 
answer book for students’ exercises, and a 
final test with answers.

! Instructor Notes manual – Guidance for 
teaching in step-by-step form for each 
lesson.

! CD-rom disk/s – Include two sets of 
PowerPoint presentations (one with audio 
guidance and one without), PowerPoint 
Viewer software, all written documentation 
(manuals) in Adobe Acrobat (PDF) format, 
and Adobe Acrobat Reader.

CNC Instructors!

Instructor Notes Manual
Slide 28 Lesson 1

This series of slides helps you describe the various 
components of CNC turning centers.  On this slide, we’re 
emphasizing the work holding device – commonly a three jaw 
chuck.  Upcoming slides help you describe other major 
components, including the tailstock and the turret.

Turning Center Programming and Operation

• Machining Center Programming-Setup-Operation
• Turning Center Programming-Setup-Operation

Two Recently Updated Courses!

Instructor’s materials

The best part…
Instructor’s materials are FREE with your 
school’s initial order for student materials!  
Visit our website for details (www.cncci.com) 

! Course manual – Over 300 pages manual 
that follows along with your presentations.

! Workbook – Including an exercise for each 
lesson (24 in the machining center course 
and 28 in the turning center course).  

Student’s materials
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Favorite analogies
You can’t have enough analogies in 
your basket of teaching tools.  
Analogies make it easier for students to 
understand complex topics by relating 
things to them that are familiar and 
easier-to-understand.  In these 
discussions (which will be included in 
each issue of Instructor Notes), we will 
relate a few favorites.  Note that these 
analogies are commonly incorporated 
right into the slide shows included with 
our curriculums.

The importance of procedures
I like to stress that running a CNC 
machine is little more than following a 
series of procedures.  The real trick is 
knowing when to perform a given 
procedure! But even once a student 
knows why and when a procedure is 
needed, fumbling through the actual 
key strokes, button pushing and switch 
activation can be frustrating – and 
there is something you can do to 
minimize this frustration.
This analogy may be aimed more at 
instructors and managers than it is 
toward students.  The analogy goes 
something like this: You should agree 
that when faced with the task of 
traveling across country for the first 
time, say from Chicago to Miami, you 
would seek a little help.  A map would 
be a must.  Or you might go to the 
Internet to download step-by-step 
instructions (a procedure) for getting 

from place to place.  The illustration 
shows an example of downloaded 
instructions.
Though you wouldn’t expect a person to 
undertake a long journey without a 
roadmap, it’s amazing how many CNC 
people are expected to memorize every 
detail needed to successfully setup and 
operate a CNC machine.  And given the 
relative complexity (and danger) of a 
CNC machine tool, why would we force 
our students memorize countless 
procedures.
I’ve been in shops that have rather  
make-shift training.  You know the kind.  
An experienced person is told to work 
with a newcomer – and somehow what 
the experienced person knows is 
expected to rub off on the newcomer.
With this kind of training, it is not 
unusual for the experienced person to 
whiz-bang through a procedure they 
know by heart – say powering up the 
machine – or setting offsets – or editing 
a program.  They then expect the 
newcomer to repeat (and even 
remember?) the procedure – after 
having seen it only once or twice.  As 
you can imagine, not much is learned 
and the situation quickly becomes 
frustrating for both the newcomer and 
the experienced person.
Admittedly, experienced people should 
memorize commonly used procedures.  
But as newcomers are gaining 
experience with a given CNC machine, 
they’re going to need some help.  As an 
instructor, you can easily provide this 
help by providing the most common 
procedures in your own operation 
handbook.

In our CNC curriculums, we provide a 
set of rather generic operation 
handbooks.  I say generic because no 
single set of procedures will work for 
more than one CNC machine tool –
especially if different machine tool 
builders are involved.  For your own 
school shops and labs, you should 
create an operation handbook for each 
of the machines your students will be 
running.
Break the handbook into logical 
sections.  Include appropriate 
procedures in each section.  Here’s an 
example:
Manual procedures

Start the machine
Perform a zero return
Start spindle
Load tools

Manual data input (MDI) procedures
Change tools
Perform a zero return
Start & stop spindle

Setup procedures
Measure tool lengths
Measure fixture offsets

Program editing procedures
Search in programs
Alter, edit, & delete word
Load programs
Delete programs

Program running procedures
Free flowing dry run
Normal air cutting run
Running first part
Re-running tools

You can probably think of more.  Just 
be sure you give students the help they 
need to feel confident as they start out.

Travel instructions downloaded from the Internet provide 
a procedure to get from one place to another.

CD-ROM COURSE!

Setup Reduction
For CNC Machining & Turning Centers

$239.00!

When machines are in setup, they are not 
producing. Anything you can do to reduce 
setup time will improve the productivity of 
your CNC machines.  In this course, we’ll 
expose many techniques to help you reduce 
setup time for the two most popular CNC 
machine types – providing you with a world 
of new possibilities for setup reduction!

! 3 hrs, 47 min of presentation on one CD
!130 page companion manual
! 63 printable handouts (over 120 pgs)
! Quick index for important topics
! Setup reduction principles
! Specific CNC setup reduction techniques

Unlimited training for just

44 Little Cahill Road
Cary, IL 60013
847-639-8847

Chicago, IL To Miami, FL 
Directions:
1:Go South on I-90(Portions toll) to Indiana
2:Go East on I-90(Portions toll) to I-65
3:Go Southeast on I-65 to I-465
4:Go South on I-465 to I-65
5:Go South on I-65 to Briley Pkwy
6:Go Southeast on Briley Pkwy to I-40
7:Go West on I-40 to I-24
8:Go Southeast on I-24 to I-75
9:Go Southeast on I-75 Florida
10:Go Southeast on I-75 to Florida Turnpike
11:Go Southeast on Florida's Turnpike

Total Distance:  1382.4 miles (2336.3 km)
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Tips for teaching CNC courses from CNC Concepts, Inc.

CNC Machining Center Programming, 
Setup, and Operation

New computer based training course! CD-ROM disk: over 6 hours!

Affordable courseware for CNC machining centers!

A very popular CNC machine type!

A proven method

CNC machining centers are among the most popular 
types of CNC machine tools.  Most companies that have 
any CNC machines have at least one.  Unfortunately, 
companies are finding it more and more difficult to find 
and hire qualified CNC people.  Many are realizing that 
they must provide extensive training to new hires and 
provide at least some continuing training to established 
employees.

The most popular control!

This affordable courseware makes it possible to train 
CNC people from scratch.  While we assume the 
student has some basic machining practice 
experience, we assume nothing about their previous 
CNC skills.  Using our proven key concepts approach, 
we bring students up to speed gradually – constantly 
building upon previously presented information – and 
we stress the reasons why things are done as 
importantly as how they’re done.  Six of the ten key 
concepts are most related to programming, and four 
are related to setup and operation.

All examples are shown in the format for the most popular 
control in the industry – the Fanuc control.  Note that many 
control manufacturers claim to be Fanuc-compatible.

What you get!
The CD-rom disk is jam-packed with over six hours of 
information about CNC machining centers.  By itself, it 
makes formidable training tool. It’s price is $149.00.
When purchased with the workbook answer combination 
($30.00), you’ll be able to confirm that you truly understand 
the material (24 exercises, one for each lesson).
When purchased with the optional student manual ($60.00), 
you’ll have a way to easily review information after you 
finish the course.
If all items are purchased (total: $239.00), we include a 
one-year subscription to our newsletter, The Optional Stop.

The price for unlimited training? … $149.00 (courseware only)
Companion manual: $60.00, workbook/answer combination: $30.00

24 lessons!
We further divide the key concepts into twenty-four 
lessons.  Lessons range from under five minutes to just 
over twenty minutes in length (total course presentation 
time is just over six hours on one CD-rom).

Contact CNC Concepts, Inc. (847-639-8847) to order!

Machining Center Course!

CNC Instructors!
If you’re using one of our proven curriculums to 
teach CNC machine tool usage, be sure your 
students know that your course is also available 
on a reasonably priced CD-rom disk.  They’ll 
already have the manual and workbook, so 
they’ll only have to purchase the courseware 
($149.00 for six hour presentation).
As a CNC instructor, you may want to make this 
courseware available for students that miss a 
lesson or want to review material you present.
Do you feel at all weak in your CNC skills?
With our CNC curriculums, we provide audio 
guidance for each lesson to help instructors 
know how to present our courses.  This is 
sufficient for instructors that are quite familiar 

with CNC.  For those instructors that may feel a 
little weak with their CNC skills, or for those who 
may be trying to teach a different machine type, 
these concise courses let you bone up on 
subject matter as quickly as possible.
Each course follows its companion curriculum to 
the letter (ten key concepts, number of lessons, 
presentation method, graphics, etc).  In fact, we 
use the same manual and workbook in the 
courseware that you use with our curriculums!  
So if you’re already using our curriculums, all 
you need is the courseware.

Turning Center Course!

see below

CNC Turning Center Programming, 
Setup, and Operation

New computer based training course! CD-ROM disk: 5.8 hours!

Affordable courseware for CNC turning centers!
A very popular CNC machine type!

A proven method

CNC turning centers are among the most popular types 
of CNC machine tools.  Most companies that have any 
CNC machines have at least one.  Unfortunately, 
companies are finding it more and more difficult to find 
and hire qualified CNC people.  Many are realizing that 
they must provide extensive training to new hires and 
provide at least some continuing training to established 
employees.

The most popular control!

This affordable courseware makes it possible to train 
CNC people from scratch.  While we assume the 
student has some basic machining practice 
experience, we assume nothing about their previous 
CNC skills.  Using our proven key concepts approach, 
we bring students up to speed gradually – constantly 
building upon previously presented information – and 
we stress the reasons why things are done as 
importantly as how they’re done.  Six of the ten key 
concepts are most related to programming, and four 
are related to setup and operation.

All examples are shown in the format for the most popular 
control in the industry – the Fanuc control.  Note that many 
control manufacturers claim to be Fanuc-compatible.
What you get!
The CD-rom disk is jam-packed with 5 hours, 52 minutes 
of information about CNC turning centers.  By itself, it 
makes formidable training tool. It’s price is $149.00.
When purchased with the workbook answer combination 
($30.00), you’ll be able to confirm that you truly 
understand the material (28 exercises, one for each 
lesson).
When purchased with the optional student manual 
($60.00), you’ll have a way to easily review information 
after you finish the course.
If all items are purchased, we include a one-year 
subscription to our newsletter, The Optional Stop.

28 lessons!
We further divide the key concepts into twenty-eight 
lessons.  Lessons range from under five minutes to just 
over twenty minutes in length (total course presentation 
time is five hours fifty-two minutes on one CD-rom).

The price for unlimited training? … $149.00 (courseware only)
Companion manual: $60.00, workbook/answer combination: $30.00


